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Objectives

* Define the Standards for Plan Summary Boxes
* Project Directory Structure
* File Naming Conventions
* Quantity Shape File Recommended Set Up

* Review the MicroStation Basics
* Models & Navigation
* Find & Replace tool
* Reference Dialog Basics
* Measurement Tools
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Plan Summary Box Standards

* Plan Summary Boxes have replaced Computation Books

* All items of work are to documented in a Plan Summary Box (Lump Sum projects &
Conventional Projects)

* Traditional “Back Up”’ (shape diagrams) are no longer provided. Location
information is provided in the summary boxes intended to be used with

the Plan Sheets.

* If quantity has been automated through the use of Computer Aided Drafting &
Design (CADD) tools, it is not the intent for reviewers or construction personnel
to review every area shape in the CADD files.

* All shapes that have been calculated with the CADD tools will have an AREA ID
included in the summary box.

* The QTDSRD file is provided with the CADD_[FPID].zip file to used when there is
an issue with the quantity in the field.
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Plan Summary Box Standards —::=.

. CADD_[FPID].zip file
* Included with every project delivery
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e Standard Project Directory Structure... » B wimas
v’ Calculations Directory -
* Look here first... > tondscp
* Contains the “Back Up” documentation for quantities g
* Excel summary box files > 0L material
* Check the Design Backup worksheet for additional documentation b :: ;::mits
* PDF files (output from programs or scanned drawings/sketches with formulas) E :: E';’;;”r:
* Custom Excel files for calculations __yp ) roadway
* Used by Roadway and Structures ’ :: e
v’ Discipline Directories, i.e. roadway, structures, etc. = > signals
- Contains the DGN files with the design, area shapes, sheets, etc. Py
- * DSGNRD**.dgn - contains Linear and Each features normally shown in plan view : :: :th
FDOTI j * QTDSRD**.dgn - contains the area shapes for SF, SY, CY,and TN B symb
J
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Plan Summary Box Standards

* QTDSRD**.dgn
* Contains area shapes used in automated calculations.
* Should be organized with “models” containing the shapes for each pay item

guantity using the pay item for the model name.

 NOTE: These are designer options but not the recommended practice.
e The shapes may be organized by DGN file and not models.
* The models may be named by description not pay item but should be easily identified.
* More than one set of shapes may be included in the same model.
* Each model is to include references showing the Alignment, Design, and Survey at
a minimum.

* All shapes will be labeled with the Area ID that is shown in the Plan Summary Box.

FDOT)

1915%2015




MicroStation Basics

* [t is recommended to open
MicroStation in the FDOT
workspace.

* By opening the files in the FDOT
workspace, the resource files used to
create the file will be available. (Most
specifically the fonts)

e Aniconis available in the FDOTSSX
folder that is created on the desktop
when the FDOT software is installed.

» “X” represents the version of the
software, i.e. SS3, SS4, etc.

(Centennial
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lcons may also be
named “FDOTSS4 for

PowerGEOPAK?”.
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) 13 items

J FDOTS54 w | ¢ |l Search FDOTS54 pel
: File  Edit Vi Tools  Help
Organize = In in library = Share with - Burn Mew felder ==« [l @
S s MName . Date modified Type Size

Bl Desktop [#f FDOTSS4 (with GEOPAK) 7/21/2015 417 PM  Shortcut 3KB
4 Libraries [#f FDOTSS4 (without GEOPAK) 7/21/2015 4:17 PM  Shortcut 3KB
‘E‘-ji Recent Places 24 ClearCrash 7/2172015 417 PM Shortcut 2KB
& Downloads = @D Create 3D Deliverables T/2/2005417PM - Shortcut 1KBE
{#f) Create Files 7/21/2015 417 PM Shortcut 1KB
o Libraries @ EC50 GoToMeeting 7/21/2015 417 PM  Internet Shortcut 1KB
@ Documents @ ECS0's Website 7/21/2015 417 PM Internet Shortcut 1EKE
J’ Music @ FDOT CADD Support Community 7/21/2015 417 PM Internet Shortcut 1KE
(] Pictures M [#% FDOT XML Signing 7/21/2015 4:17 PM  Shortcut 1KB
Subversion FileChecker 7/21/20054:17PM  Shortcut 1KB
B videos B\ Key Sheets T/2/2015417PM  Shortcut 1KB
E LandXMLVisualizer 7/21/2015 417 PM  Shortcut 1KB
u-,J Computer @] XML Quantity Rounder 772172015 417 PM Shortcut 1KB




MicroStation Basics

* On the File Open dialog, toggle on the option to open the file “Read
Only”. This helps to insure the integrity of data within the file. When
a file is opened to write access (whether the file is changed or not)
MicroStation saves the file automatlcally and the date/time stamp of
the file changes.

E3 —
- QrrE DHAE® 20 - V8 DGN
Mame = Date modified Type
.. eng_data 7/24/201512:25 PM  File folder
= [ ALGNRDO1.DGM 12/71/2014 3:44 PM  Bentley M
: /% CESSRDOL.DGN 7/8/20151:25PM  Bentley M
. . : /% DSGNRDO1.DGN 7/21/20157:33PM  Bentley M
* Onl the fil th th -
n y O p e n e I e WI e esktol /% GDTMRDOL.DGM 5/20/2015 202 PM  Bentley M
° . ° = /8 keysrd01.dgn 5/13/2015 3:23 PM Bentley M
Optlon toggled Off When |t IS the : /% QTDSRDOIECS0.DGN 8/7/20151208 PM  Bentley M
ibraries /% SUMQRDOLECSD.DGN §/5/20153:33PM  Bentley M
1 k h 1 t h % TYPDRDO1.DGN 7/31/201411:22 AM  Bentl
tent to m - 2 s
ln en O a e C anges ln e iy /8 TYPSRDOL.DGM 8/11/2014 815 AM  Bentley M

file (i.e. AS‘BUiIt planS). o ier ‘ﬁWEkulla.dgn ) 8/11/2014 8:15 AM Bentley:\ﬂ

QTDSROO1ECSO.DGM

- ile name: A
MNetwork

enfennfa[ Files of type: [C}\D Files (*.dgn:”.dwg;”.dd) M
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* Each DGN is a compilation
of “Models”. Each model
contains a separate
drawing space.

* Once the file is opened, the
first thing to do is make
sure you are in the correct
model. The model nameis
at the top of the “View”
window.
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* MicroStation uses files with the “DGN” extension. AN

[ C\e\554P oject:\22049555201\roadway\QTDSRDO1ECSO.DGN [20 - VB DGN] - MicroStation Vi (SELECTseries 3]

File Edt Eement Settings Tools

T
§ v AX a vViewd0522 1

& - |[crar

Lkilties Worespace Applications  Window  Subsurface Ltility  Help

Tasks hd ]
[SH FDOT Plans Development
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}J?i

Typical Sections
Key Sheets
Roadway Plans
Existing Features
Cross Sections

Drainage Plans

c(e[¢||¢[|¢| ¢ ¢

Traffic Plan=
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MicroStation Basics

* To change the active model...
* Open the Models dialog

* File > Models

__O r__

* Click on the Models icon on the Primary Tools toolbar
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Close Ctd+W
H Save Ctd+5
Save As..
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% Mem Browser
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MicroStation Basics

* Models Dialog Box
e Model name in Green is the active model.

* Double clicking on a model sets it to the active model and opens it to the
view.

- - ¥ ¥ | 7
%MI\I‘EHE d%ﬁ'xr L
Type 20730 Mame Description

Default Master model

T With this option,
0334 122 Supemave Asphattic Concrete you see the model

0337 740 Friction Course

0285706TL Option Base - Group & names as We” as

0522 1 Sidewsalk - 4"

0236 1 Tumout Construction the description.

0Z28h7065HLDR  Option Base - Group &

OO0 00u00
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MicroStation Basics

OR...

* Click on the View Group drop down menu at the bottom left corner
of the screen.

* Select the model from the list that you want to open.
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1915%2015

E‘v'lv‘u'lv."-,_v

Model

0286 1 Views

770 8 Views
IEWS

Tthe 0337 7 40 Views

' 0522 1 Views

'L 02857065HLDR Views

'L 0285706 TL Views

It Default Views

0236 1

0327 70

0337 740
0522 1
02857065HLDR
0285706TL
Default

| |[]2]3]4ls]s]7]8] : X [2006440 655387

Element Selection > |dentify element to add to set

With this option, you only
see the model names. It is
also possible that not all of
the models are included in
this list. If not, you’ll need to
open the Models dialog box.




MicroStation Basics

* Once the desired Model has been opened, the contents can be
viewed.
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MicroStation Basics

* If the references have not been left turned on, they can be turned
on using the References dialog.

* References can be accessed by:

* File > References
* References icon on the Primary Toolbar (right next to the Models icon)

Tools  Settings

Slat ¥ 5 File Name Maodel Desu‘ip‘tinn Logical Crientation Presertation [=] .J

ALGNRDIN.DGMN ~ ALGNRD_50 Global Origin aligne... Coincident - Word Wireframe
DSGMRD0.DGN  Default Master model Coincident - Word Wireframe
TOPORDO.DGMN  Default Master model Coincident - Word Wireframe

Scale | 1.000000 | - [ 1.000000 | Botation [00°0000" | Offset X | 0.000000 | Y [ 0.000000 |

I"_||_||_|[E]|_||_| e BB I:' .|:| M Mested Attachments: Mo Nesting > | Display Ovemides: [Alow  ~ | Mesting Depth:

enfenmal Q% New Level Display: [Config Variable ¥ | Georeferenced: [No
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MicroStation Basics

* Click in the Display column to toggle the references on and off.
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Tools  Settings

By EDE AP M D ITQ D et

St ¥ (3 File Name Model Description Logical Crientation

F‘reserrtatiui | |'_'k| | ad

ALGNRDO1.DGN  ALGNRD_50 Global Crigin aligne. .. Coincident - Warld
DSGMRD0T.DGHN  Default Master model Coincident - Word
TOPORDOT.DGM  Defaul Master model Coincident - Word

Scale | 1.000000 ;| 1.000000 Botation | 00°00°00" Offset X | 0.000000

|"_||_||_|[::'l]|_||_| - ¢* B @I:' .|:| . Mested Attachmerts: |No Nesting = | Display Ovemides: [Alow | Nesting Degth: |1
Mew Level Display: [Corfig Varable | Georeferenced: Mo

Wireframe iﬂLL
Wireframe Display

Wireframe “

¥ | 0.000000




MicroStation Basics

* Having the references turned on gives you a better feel for where
you are looking in the project.

B Viewl 0522 1 [ Stendard | CellApps | Actions | Design Apps | Roadway _Trafic Control _Traffic Plans | v |7 | T (k| 5[ @] == =
D28 AQRIREY O BE|HRE
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MicroStation Basics

* To locate the shape for a quantity...

get the AREA ID from the Plan Summary Box.

SUMMARY OF SIDEWALK & DETECTABLE WARNINGS
CONC SIDEWALK
rocarion AREA E = - DESIGN CONSTRUCTION
sioe io = § 9522 1 NOTES REMARKS
STA. TO STA. - Al
P F

F0I1+34 00 to 705+70.899 LT 18827 291.3
705+70.99 to 7I12+37.08 LT 18838 466.2
FI12+37 .08 to 7I14+57 .32 LT 18848 1457
G99+08 .00 to 6399+66.00 RT 18809 57 .6
700+42.00 to 70I+00.00 RT 18821 57 .6
F0I+00.00 to 705+70.99 RT 18832 314.0
FO05+70.99 to T7I2+37.08 RT 18843 421.9
F7I12+37 .08 to 7I14+55.65 RT 18856 138.7
SUB-TOTAL: 1893.0

TOTAL: 1893
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MicroStation Basics

* To locate the shape for a quantity...

* Go to Edit > Fmd/Replace Text in MicroStation

: Fe EdrtlEIernerrt Settings  Tools |Hilties Wolkspace Appications Window Sussurface Utility Help

w3 Undo Refeence Seting Change  Cids7
Undo Dthe +
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& Cut Cir+¥

Fu  Crua Clil="

s =M b

- ___u ey

.3 L.:l:iu:' _n=-v
Faste Special
Groin (td+5
Lmarooan Cir=ll
Ungroan Cidsll
| ol sl
Liiny Ll
Unlock Ciri+
Ering to Frent

1! Fnd/Replace Tad «

Eelect Al Cirl+A
=elect Nore
Lelect Dy Attributes

ODE Unks ..
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MicroStation Basics

* To locate the shape for a quantity...

* Type in the AREA ID in the Find: field of the dialog and click Find

)‘-'* _ﬁmd!ﬁe lace text I

Find: 18827

Feplace:
— | Find Opticns
Match Case ‘whole \Words

lUse Regular Expressions In Cells

— View Options
| Animate

| Zoom (4

Hint: Leave Animate and Zoom toggled on. When you
click on Fmd |t Wl” zoom into the shape you are Iookmg

Replace All | |

Fick

(Centennial
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MicroStation Basics

* Once the area shape has been located, the Measure tools can be
used to measure distances, areas, element lengths, etc.

e Distance
* Radius
Measure - Tas
* Angle
* Element Length e A A H O
* Area

* Volume (Not valid for 2D plan shapes)

* Note: Measurements are in Master Units. For the FDOT workspace this is Survey Feet.
(which means linear measurements are in FT and areas are in SF not SY)

FDOT)
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MicroStation Basics
Product Add-ins (3
[ Tasks
Animation (3
* Measure tools can be accessed w
4 Comidars 4
from several locations Carcaom
Civil Cells (3
* Tools Menu OiGemay
File Edt Eement Settings Tools LUiilities W ¢ TaSk Menus S::Li:::zr:ems :
s M “‘ " View * Tasks o e
2o 9| B | | S
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%  Note: Click and hold to scroll down the list S g
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Q’E[t.ﬂ:j 6 Measure Volume Paint Cloud P% ; Measure Volume
ﬁ}m Project Navigation Pﬁ Gpen as Tool Box
(coa = Open 'Measure’ as Toolbox Properties *
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* Mleasure Area

e Select the Measure
Area Tool

* Click on the shapein
the view

 Take the Area Value
populated in the

Measure Area dialog
box and divide by 9.

e Compare to the value
in the Summary Box

(Centennial

MicroStation Bq_sics\

Method: | Element b

Tolerance {%): | 0.001000
Mags Properties
Display Certroid

About: |Global Z hd
Area Unit: [ Square’ -]

C frea: | 2621913950, )
Perimeter Unit: |Survey Feet -

Permeter: | 885.971284°

View Edit Help
291.323766bbbEBET
- -
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More MicroStation Training

* More training is available for FDOT employees or
contractors/consultants working from a FDOT office (i.e. have a
DOT e-mail address)

* FDOT has a subscription to Bentley’s Learn site which provides training on
all Bentley products. Contact the Jennifer Weeks in ECSO to get registered
and set up for a MicroStation Basic Learning Path.

FDOT)
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Need some HELP? Contact me... ey NN
(850) 414-4751 7/ / ]\\\
E-mail: Denise.Broom(@dot.state.fl.us
OR: ecso.support(@dot.state.fl.us
http://www.dot.state.fl.us/ecso

FDOT CADD Support Forum On-line

http://communities.bentley.com/communities/user communities/fdot cadd support/default.aspx

FDOT)
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